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Overview

Important note

Thank you for purchasing View. 

This user's guide describes how to install and operate, and details of precautions for use.

Please read this user's guide carefully before using the program, and use the product according to

the instructions. Also, please keep this user’s guide properly so that you can refer to it when using 

the program.

Please keep this user’s guide with the product.

If program modification or re-installation is needed, please contact the K LAB customer service center. 

If the user's guide is lost or damaged, please contact the K LAB customer service center.

Copyright

•The spectrophotometer Series and PC software View are the registered

 trademarks of K LAB Co., Ltd.

•All related materials in this guide should not be modified or distributed in any form without the

 prior consent of K LAB.
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Ch. 1
Overview and general information

1-1 Getting started with View   

1-1-1 Overview 

1-1-2 Before you start 

1-1-3 Recommended specifications 

1-2 View Installation  

1-2-1 Installation 

1-2-2 Progress 

1-2-3 Matters to check after installation 

1-3 Screen Overview 

1-3-1 Basic tab 

1-3-2 Tools tab  

1-3-3 Settings & help 

1-3-4 Version information and status bar

1-4 Connecting devices 
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1-1 Getting started with View

1-1-1 Overview

View is a Windows-based PC program that can control the operation and data of K LAB Series 

spectrophotometers using the general PC.

1-1-2 Before you start

View is software for the PC interface of K LAB Series spectrophotometers, which enables the user to 

check the sample measurement result in real-time in the Windows environment and manage the overall 

equipment and measurement more easily.

1-1-3 Recommended specifications

Name of item Minimum specifications Recommended specifications

Operating Windows® 7, 8, 10 Windows® 11

Processor
Intel® Pentium® D or AMD™ 

Athlon® ™ 64 X2

Intel® Core 2 Duo E6600 (2.4 GHz) or 

AMD™ Athlon™ 64 X2 5000+ (2.6 GHz)

Or higher

Video

NVIDIA® GeForce; 6800 (256 MB)

or ATI™ Radeon™ X1600 Pro (256 MB) 

or higher

NVIDIA® GeForce; 8800 GT (512 MB)

or ATI™ Radeon™ HD 4850 (512 MB) 

or higher

Memory 4 GB RAM 8 GB RAM

Capacity Free hard drive space of 1GB or more Free hard drive space of 1GB or more

Resolution At least 1920 x 1080 display resolution 1920 x 1080 display resolution or higher

Ch.1
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1-2 View Installation

1-2-1 Installation

Find and run the installation fi le (view.msi) of View.

* Download the view.msi fi le from the View installation CD provided or from the K LAB website.

1-2-2 Progress

1. Prepare View installation.

2. Press the [Cancel] button to stop installation.

3. Select a folder to install View.

*  Press the [Next] button to use the default folder location suggested by View, or press the [Browse]

button to change the installation folder and install View. Press the [Cancel] button to stop installation.

* The appearance of the view.msi icon in this manual may vary, so please double-check.

Ch.1



12 View User Guide Book

4. When you are ready to install View, Press the [Install] button.

5. When the installation is complete, Press the [Finish] button.

6.  If you do not have Microsoft Windows Desktop Runtime on your PC, you will see the installation screen 

as shown below. (If it is already installed, the following steps will be skipped).

7. Press the [Install] button.

Ch.1
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8. When the installation is complete, Press the [Close] button.

9.  All installation processes have been successfully completed, and the shortcut icon [View] will be added 

to the desktop.

1-2-3 Matters to check after installation

Check to see whether View is installed correctly.

Check to see whether the following folder is created in the hard disk drive after installation to see if the

program is properly installed.

* When installing to the default folder

  Note that a fi le is created in the path C:\Program Files\K LAB\View. 

Ch.1
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1-3 Screen Overview

1-3-1 Basic tab

❶ ❷ ❸ ❹

❶  Photometric: This mode measures the absorbance or transmittance of a sample at one or multiple 

(up to 20) wavelengths.

❷  Spectrum: This mode measures the absorbance or transmittance of a sample over a set range of 

wavelengths.

❸ Kinetics: This mode measures the change in absorbance or transmittance over time.

❹  Quantitation: This mode builds a standard curve at the wavelengths you set and measures the 

concentration.

Ch.1

-  Explanation: Instruments may have separate Application menus depending on the product 

purchased. Also, depending on the SW mode, functionality may require a login or be restricted by 

permissions.

- If the product is QX: You will see additional modes for measuring Hach, Merck, etc.

-  If in Security mode: Features are restricted based on the permissions of the account you are 

logged into. (For more information, see SW Mode).

Note
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1-3-2 Tools tab

❶

❻

❷

❼

❸

❽

❹ ❺

❶  Network: Launches the Network Connections window.

❷  IP Confi guration: Displays the computer's TCP/IP network settings.

❸ Console: Runs the computer's command prompt.

❹ Explorer: Launches the computer's Windows Explorer.

❺ Ping: Runs a program that tests whether a specifi ed host is reachable over the network.

❻ Event Viewer: Runs your computer's event log.

❼ Calculator: Runs the calculator on your computer.

❽ Log: Records and manages actions or events within a program.

Ch.1
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Ch.1
1-3-3 Settings & help

1-3-4 Settings & help

❶

❻

❷

❼

❸

❽ ❾

❹ ❺

❶  Connect to device: Attempt to connect with the device.

❷  Disconnect: Disconnect from the device.

❸ Connection Settings: Set up a connection (IP address, auto-connect) with the device.

❹  View settings: Set the view, including language, precision, and style.

❺ Device settings: Set device blah blah blah.

❻ Help: Enable help (F1).

❼  Support: Link to technical support.

❽  Feedback: Links to suggestions and feedback.

❾ Information: Shows information about the program (contact, serial number).

- SW: Displays version information for View.

- App: Displays the app version information for the device.

- FW: Displays the Firmware version information of the device.

- Time: Indicates the current time.

-  Time and output time (report) follow the regional format displayed in the Windows. Therefore, if you 

want to change the time, you need to change the display time in the Windows.

- Lamp Status: Indicates the status of the W-lamp and D2-lamp. 

- Communication status: Indicates the communication status with the device. 

Status bar
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❶ Put the device into PC-Link state.

❸  Tap Settings & Help > Connection Settings and enter your device's IP address

- ex) 192.168.0.12 (enter the address from PC-Link)

- If you set up an automatic connection, the program will try to connect automatically when it starts.

❹ Press the [OK] button.

❺ Press the [Connect to Device] button on the home screen.

* When connecting for the fi rst time, the serial number input window is displayed as follows.

❻ Enter the serial number and press the [OK] button.

❼ Confi rm that communication is established with the device.

1-4 Connecting devices
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Ch. 2
Introduction to settings and screens

2-1 View settings  

2-2 Device settings 

2-3 Ribbon menu 

2-3-1 The [Home] tab

2-3-2 The [View] tab  

2-3-3 Quick access toolbar

2-3-4 Tooltip

2-3-5 Toolbar

2-4 Window layout (Common)

Ch.2
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Ch.2

2-1 View settings

❶

❷

❸

❹

❺

❼
❻

❶  Language: Sets the language of the program.(Supported languages: English, Korean, 日本語, 中文)

❷  Precision: Set the precision displayed within the program.(Absorbance, Transmittance, Concentration)

❸ Date/Time Format: Set the format of the date and time displayed within the program.

❹  Favorites (tabs): Allows the user to set the order of tabs on the home screen.

❺ Preview options: Set whether to preview the options window when entering the measurement screen.

❻ Task explorer (path): Set whether to specify a save or open path.

❼ Shortcut: Set the mode to run automatically when the program is launched.

❽  Chart style: Set the style of the chart.

-  Strips: Set the style of the chart's stripes. (Depending on the Transparency - Alpha setting, the 

measure may not be visible).

- Peak, Valley: Set the re to display when setting P/V in Spectrum mode.

- Series Color: Shows the measurement data in a repeating series of 10 colors.

❾  Table Style: Set the style of the table.

-  Pass, Fail: Set the color to indicate pass or fail according to the formula in Photometric or the formula 

in Quantitation.

*Press the [Reset] button to return the style to its initial state.

❽

❾
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2-2 Device settings

❶

❷

❸

❹

❺

❻

❶  Cell holder: Sets the currently mounted cell holder.

❷  Initial Cell Position: Set the initial position of the cell. (Only for multi-cell holders)

❸ Initial Wavelength: Set the initial wavelength.

❹  Lamp change wavelength: Set the wavelength at which the lamp changes. (Only if equipped with a D2 

lamp)

❺ Auto Blank

-  Auto: Measure a blank cell for every measurement and use it as a blank. When enabled, the blank cell 

can also be used in the measurement.

-  Manual: Manually measure and use a blank value. The blank cell can also be used as a sample 

measurement location.

❻ BIT (self-diagnosis): Performs diagnostics of the instrument item by item.

- Wavelength Motor: Diagnose the health of the wavelength motor.

- Cell Motor: Diagnose the health of the cell motor.

- Filter Motor: Checks the fi lter motor for normal operation.

- Lamp Motor: Checks the health of the lamp motor.

- W-lamp: Checks the W-lamp light output.

- D2-Lamp: Checks whether the D2 lamp luminous intensity is normal or not.

- D2-Lamp (Peak): Diagnoses wavelength accuracy using the D2 lamp.

(If the self-diagnosis fails, follow the troubleshooting procedure or contact the manufacturer).
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2-3 Ribbon menu

❶  File

- New: Create a new method.

- Load: Load a save fi le.

- Save: Save the fi le.

- Save As: Save the fi le with a different name.

- Load Parameter: Load a saved parameter.

- Save Parameter: Save the fi le as a parameter.

❷  Measurement

- Measure settings: Set measurement parameters.

- Blank: Measure a blank.

- Baseline Correction: Correct the baseline.

- Sample: Measure a sample.

❸ Graph

- Zoom to 100%: Reset the zoom of the graph to 100%.

- Zoom to fi t: Fit the zoom of the graph to its size.

- Overlay: Overlay the slope that is displayed when using latency in Kinetics mode.

- Axis Reverse: Used only with standard curves in Quantitation, inverts the axes of the graph.

- Tooltips: Show or hide tooltips for the graph.

- Vertical Crosshairs: Show or hide vertical crosshairs.

- Horizontal Crosshairs: Show or hide horizontal crosshairs.

- Axis: Set the visibility of the graph's x and y axes.

- Horizontal zoom bar: Show or hide the horizontal zoom bar.

- Vertical zoom bar: Show or hide the vertical zoom bar.

- Overview: Show or hide the overview of the graph.

- Legend: Show or hide the legend for the graph.

- Flip: Set whether the graph is fl ipped horizontally.

2-3-1 The [Home] tab
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❶  Table

- Table Item: Shows or hides table entries.

- Record Selector: Show or hide the record selector.

- Summary: Show or hide the summary of the table.

- Sort: Sort the list in the table.

- Freeze Rows: Enable/disable freeze rows for the table.

- Freeze Columns: Enables/disables column freezing for the table.

-  P/V: Allows you to fi nd the peaks and valleys of your measurement data. (Only visible in Spectrum 

Mode)

❷ Export

- Excel: Export the fi le to Excel (workbook).

- CSV: Exports the fi le as a CSV (comma-separated values).

- Text fi le: Exports the fi le as a text document.

- Image fi le: Exports the graph as an image fi le.

❸ Print

- Print: Print the current document.

- Print Preview: Displays a print preview.

- Landscape Orientation: Specifi es that the page content is printed in landscape orientation.

- Portrait Orientation: Specifi es that the page content prints in portrait orientation. 

- Printer Settings: Launch your computer's printer settings window.
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2-3 Ribbon menu

❶  View

- Task Explorer: Show or hide the task explorer.

- File Explorer: Show or hide the fi le explorer.

- Real-time data: Show or hide real-time data.

- Measurements settings: Show or hide measurement settings.

- Cell holder: Show or hide cell holder.

- Event logs: Show or hide event logs.

· Notifi cations: Show or hide notifi cation information in the log.

· Warnings: Show or hide warning information in the log.

· Errors: Show or hide error information in the log.

- Graphs: Show or hide graphs.

- Tables: Show or hide tables.

- Status Bar: Show or hide the status bar.

❷ Layout (The layout is set as the default on save and is applied every time the window is launched).

- Reset Layout: Resets the window layout.

- Load Layout: Load a window layout.

- Save Layout: Saves the window layout.

❸ Window (Can be dragged and dropped for context).

- New Horizontal Tab Group: Creates a new group in a horizontal format.

- New Vertical Tab Group: Creates a new group in vertical format.

- Move to Previous Tab Group: Moves the current tab to the previous group.

- Move to Next Tab Group: Moves the current tab to the next group.

- Close: Closes the current window.

2-3-2 The [View] tab
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❺  Remove from Quick Access Toolbar: Removes the command from the quick access toolbar. (You can 

remove it by pressing the right button on the quick access toolbar).

❻ To run the quick access tool, you can run [ALT + 1], [ALT + 2], starting from the left, in that order. 

- For example, if you added New, Load, and Save to the quick access tool.

· New: ALT + 1

· Import: ALT + 2

· To save: ALT + 3

❼  When you close the window, the quick access tool is saved and will be applied each time you open the 

window.

2-3-3 Quick access toolbar

❶ Show below the Ribbon: Displays the tool below the ribbon menu.

❷ Show above the Ribbon: Show the tool above the ribbon menu. (Default)

❸ Minimize the Ribbon: Minimises or cancel the Ribbon menu.

❹  Add to Quick Access Toolbar: Adds the command to the quick access toolbar. (You can right-Press on 

the command to add it).

2-3-4 Tooltip

❶ Hovering over the menu button displays a tooltip, as shown in the fi gure.
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❶ SW: Displays version information for View.

❷ App: Displays the app version information for your device.

❸ FW: Displays the fi rmware version information for your device

❹ Home: When Pressed with the mouse, the Home screen is displayed.

❺ Monitor: Moves the current window's position to the corresponding monitor.

❻ Collapse/Expand Menu: Collapses or expands the ribbon menu.

Ch.2

2-3-5 Toolbar
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2-4 Window layout (Common)

❶  Task Explorer (Separate and manage the fi les you are working on in explorer (folder) form.)

- New folder: Create a subfolder in the selected folder.

❷ File Explorer (Separate and manage fi les in the Explorer (folders).)

- Rename: Rename the selected folder.

- Delete Folder: Deletes the selected folder. (However, you can't delete it if it has subfolders).

- Expand All: Expand the subfolders of the selected folder.

- Collapse All: Collapse the subfolders of the selected folder.

- Open the fi le in File Explorer: Navigate to the folder with File Explorer.

- Filter: Use the fi lters to search by fi le type.

-  Open: Open the selected fi le. (Depending on the fi le type, the fi le will open with the associated program).

- Delete: Delete the selected fi le.

- Details: View the details of the selected fi le.

- Open folder in File Explorer: Navigate to the fi le in File Explorer.
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❸  Real-time data

❹ Measurement settings

❺ Cell holder

- Monitor real-time measurements of connected equipment.

- Change the wavelength or perform autozero.

- Check the parameters used in the measurement.

- Indicates the holder and state of the currently set cell.

- If it is a multi-cell, you can change the status and position of the current cell.

- If you have set up Auto Blank in the machine settings, you can use the Auto Blank function here.
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❻  Log

❼ Status bar

❽  Pane Navigation: You can switch between open panes by pressing ALT + F7 or CTRL + TAB (Document 

pane).

- Represents logs within the program.

- Logs are of different types (notifi cations, warnings, errors) depending on their status.

· Filter: Shows the contents based on type.

· Clear: Clears all current content.

· Save: Saves the current contents in CSV format.

- Time: Indicates the current time.

· The time and output time (report) follow the regional format displayed in the window.

· Therefore, if you want to change the time, you need to change the display time in the window.

- File: Displays the path and name of the fi le.

- Home: When Pressed with the mouse, the Home screen is displayed.

- Lamp: Displays the status of the lamp (on/off).

- Status: Displays the communication status. (Same as the status on the home screen)

· Disconnected: When Pressed with the mouse, attempts to reconnect.

❾  Manage layouts (Window position)

- Floating: No longer a visual element of the screen, so it is confi gured as a separate screen.

- Dockable: Confi gured as a visual element of the screen, so it can be docked as part of the screen.

- Hide: Hides the pane. To show it on the screen, select the window in the View tab.

- Auto-hide: Hides the window except for the header. This is useful if you have a small monitor screen.

- Dock: Allows you to dock the window where you want to move it, as shown below.
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3-1 Photometric Mode

❶  File name: Set the name of the fi le.

❷ Wavelength: Set the measurement wavelength.

- Up to 20 settings are possible.

❸ Formulas

- Using formulas, you can compute and analyze measurements.

❹ Repeat measurements

- Allows for repeat settings from 2 to 99 times.

- Repeated results can also display raw data, mean, and standard deviation.

❺ Speed: Set the measurement speed.

❻ Units: Set the units of the sample. (Units can be entered directly).

❼ Photometric Type: Set the photometric format of the measurement results.

❽ Memo: Enter a note.

3-1-1 Measurement settings
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❺ Generate a standard curve

-  If you have more than one measurement result, you can create a standard curve from the absorbance 

results at those wavelengths.

- Select the absorbance, right-click, and press 'Send to Standard curve'.

3-1-2 Measurement

❶ Select the cell you want to measure in [Cell Holder].

❷  Press the [Blank] or [Baseline Correction] button. (The button you see depends on the number of 

wavelengths you have set).

❸ Press the [Sample] button.

❹ The measurement results appear in the table and graph.

- If you used a formula, the result appears in Column F.

- If you used repeat measurements feature, detailed data appears at the bottom of the data row.



34 View User Guide Book

3-2 Spectrum Mode

❶  File name: Set the name of the fi le.

❷ Wavelength: Set the wavelength range and interval.

❸ Repeat measurements

- You can set the repeat settings from 2 to 99 times.

- Repeated results can also show raw

❹ Speed: Set the measurement speed.

❺ Photometric Type: Set the photometric format of the measurement results.

❻ Memo: Enter a note

3-2-1 Measurement settings

3-2-2 Measurement

❶ Select the cell you want to measure in [Cell Holder].

❷  Press the [Baseline Correction] button.

❸ Press the [Sample] button.

❹ The measurement results appear in the table and graph.

Ch.3
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❻ Generate a standard curve

-  If you have more than one measurement result, you can create a standard curve from the absorbance 

results at those wavelengths.

- Select the absorbance, right-click, and press 'Send to Standard curve'.

❺ If you used Peak/Valley (P/V), the data will appear in the P/V tab.

- By adjusting the Threshold, you can extract the desired peak and valley values.

Ch.3
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3-3 Kinetics Mode

❶  File name: Set the name of the fi le.

❷ Wavelength: Set the wavelength range and interval.

❸ Luminosity format: Set the luminosity format of the measurement results.

❹ Time units: Set the units of time displayed in graphs and tables.

❺  Total Time/Time Interval: Set the total time taken for the measurement and the interval between 

measurements.

❻ Lag Time/Rate Time 

- Lag Time: The delay between the start of an event and the full effect (reaction).

- Rate Time: Absorbance change divided by time as a range to get the slope of the rate of change.

❼ Factor: Sets the factor used for the measurement.

❽ Memo: Enter a note.

3-3-2 Measurement

❶ Select the cell you want to measure in the [Cell holder].

❷  Press the [Blank] or [Baseline Correction] button. (The button you see depends on the number of 

wavelengths you have set).

❸ Press the [Sample] button.

❹ The measurement results appear in the table and graph.

❺  If you used lag/rate time, the table columns will display Init. Abs, dAbs/min, and Activity appear in the 

table columns

3-3-1 Measurement settings

Ch.3
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3-4 Quantitation Mode

❶  File name: Set the name of the fi le.

❷ Dilution factor: Set the dilution factor used for the measurement.

❸ Repeat measurements.

- You can set the repeat settings from 2 to 99 times.

- Repeated results can also display raw data, mean, and standard deviation.

❹ Memo: Enter notes.

❺  Standard curve

- Measurement types

· 1 λ: Measurement with one (1) wavelength

· 2 λ: Measurement with two (2) wavelengths (peak and base)

· 3 λ: Measurement with three (3) wavelengths (peak, base1, and base2)

· Derivative: 1st ~ 4th derivative of selected wavelength

- Make type

· Make standard curve: Enter a measurement or value to create a standard curve

· Standard curve types: linear, quadratic, and cubic curves

· Equation: Create a standard curve by entering your own formula

- Units: Set the units for the sample. (Units can be entered directly).

3-4-1 Measurement settings

Ch.3
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❻ Pass/fail

❶ Add and delete samples

-  Users can enter concentration and absorbance directly or enter concentration and measure 

absorbance to generate a standard curve.

-  In the above case, selecting one cell requires three separate measurements. By selecting three cells, 

the result can be obtained from a single measurement.

- Use the formula to set the pass/fail for a measure.

3-4-2 Standard curves

3-4-3 Quantitative measurements

❶ Select the cell you want to measure in [Cell Holder].

❷ Press the [Blank] button. (To use a pre-measured blank, skip this step)

❸ Press the [Sample] button.

❹ The measurement results appear in the table and graph.

Ch.3
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3-5 QX

❶  File name: Set the name of the fi le.

❷ Dilution factor: Set the dilution factor used for the measurement.

❸ Memo: Enter notes.

3-5-1 Measurement settings

3-5-2 Select a method

3-5-3 Measurement

❶ Select the cell you want to measure in the [Cell holder].

❷ Press the [Blank] button.

❸ Press the [Sample] button.

❹ The measurement results appear in the table and graph.

-  Depending on whether the concentration is within the range, the text is coloured differently (within 

range: green, out of range: red).

❶  Favorites: Displays the favorites parameters. (Only the favorites parameters on the instrument are 

displayed).

❷ Number: Search for a parameter by number.

❸ Name: Search for a parameter by name.

❹ Select method: Allows you to select an item from the searched parameters.

- Range: Measurement results can be trusted if they are within the range.

Ch.3
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3-6 Printing out a report

❹ Option

❶  Specify the output orientation (landscape, portrait) of the page content.

❷ Press the [Print Preview] button.

❸ Check the information in the print preview window and press the [Print] button.

- Logo: The logo that appears in the header of the output.

- Header text: The text that appears in the header of the printout.

- Page number: The number of the page that appears in the footer of the printout.

- Printed time: The time the print was printed is displayed in the footer.

- Footer text: The text that appears in the footer of the printout.

- Title: Choose whether to include a title for the printout.

- General: Choose whether to include general information in the printout.

- Graph View: Choose whether to include a graph in the output.

- Table View: Select whether to include table information in the output.

- Design mode: Choose whether the user will edit the items they want to output directly.

Ch.3
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4-1 Formulas

❶ Description

- A formula is an equation that performs a calculation on table values.

- �You can use functions, variables, constants, and calculation operators in formulas. If you want to 

reference a variable instead of a constant, you can use a value (for example, [A600]+[A700]).

❷ Entering formulas

- ��You can also create formulas using functions, which are predefined formulas that simplify entering 

calculations.

3 + [A550] * SUM([A500],[A700])

- Constants, such as values or text values, can be entered directly into formulas.

- �The operator specifies the kind of calculation that the formula performs. For example, the ^ (caret) 

operator powers up a number, and the * (asterisk) operator multiplies a number.

- �Functions are pre-made formulas that can be used alone or as part of a longer formula. Each function 

has a specific argument syntax.

- �Variable values allow you to refer to a variable instead of a specific value inside a table so that the 

contents of the table can change without referencing the function.

❸ Using constants in formulas

- Constants are uncalculated values and always remain the same. 

- �For example, the date 9 October 2008, the number 210, and the text "Quarterly revenue" are all 

constants. Neither the expression nor the result of the expression is a constant.

- �If you use a constant in a formula (for example, 30+70+110), the result will only change when you 

change the formula.

- �It's usually best to place constants in individual cells where they can be easily changed if needed, and 

then reference them in formulas.

❹ Using calculation operators in formulas

- �Operators specify the type of calculation to perform on formula elements. Calculations follow a basic 

order as per normal maths rules, but you can use parentheses to change this order.
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4-2 Variable

❶ Description

- �The following variables can be used in the formula. They must contain the characters '[' ']' characters 

to be recognized as a variable.

· [W550] 550 nm wavelength variable 

· [A550] 550 nm absorbance variable 

· [T550] 550 nm transmittance variable 

· [I550] 550nm intensity variable

❷ Functions & Absorbance Variables

3 + [A550] * SUM([A500],[A700])

① Constants 

② Operators 

③ Functions 

④ Variables

❸ You can create formulas by adding variables and functions, such as above. 

❹ �For example, if the formula is SUM([A500],[A600]), the value returns the sum of the absorbance at 500 

nm and the absorbance at 600 nm.

❺ Example

① ② ③

④

- [A500] - [A320] returns the absorbance at 500 nm minus the absorbance at 320 nm. 

- [A500] < 1 Returns a pass if the absorbance at 500 nm is less than 1.

Ch.4
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4-3 Function

❶ Maths functions

- ABS: Returns the absolute value.  

- ACOS: Returns the arccosine, or inverse cosine, value.  

- ACOSH: Returns the inverse hyperbolic cosine value.  

- ASIN: Returns the arcsine, or inverse sine, value.  

- ASINH: Returns the inverse hyperbolic sine value.  

- ATAN: Returns the arctangent, or inverse tangent, value.  

- ATAN2: Returns the arctangent, or inverse tangent, value at the specified x, y coordinates.  

- ATANH: Returns the inverse hyperbolic tangent value.  

- CEILING: Returns a number raised to a multiple of significance.  

- COMBIN: Returns the number of combinations that can be made with the given number of items.  

- COS: Returns the cosine value of the given angle.  

- COSH: Returns the hyperbolic cosine value.  

- DEGREES: Converts radians to degrees.  

- EVEN: Returns a number rounded up to the nearest integer.  

- EXP: Returns e raised to the power of a number.  

- EXPON: Returns the value of an exponential distribution.  

- FACT: Returns the factorial of number.  

- FACTDOUBLE: Returns the double factorial of number.  

- FLOOR: Returns the nearest multiple of significance by rounding the number down towards zero.  

- GCD: Returns the greatest common divisor of two or more integers.  

- INT: Rounds down to the nearest integer.  

- LCM: Returns the lowest common multiple of an integer.  

- LN: Returns the natural logarithm of the number. 

- QUOTIENT: Returns the integer part of a division quotient.  

- RADIANS: Converts units of degrees to radians.  

- RAND: RAND returns a random number that is a real number greater than 0 and less than 1.  

- RANDBETWEEN: Returns an integer random number between two specified numbers.  

- ROMAN: Converts Arabic numerals to Roman numerals, which are text.  

- ROUND: The function rounds a number to the specified number of digits.  

- ROUNDDOWN: Rounds down a number in a direction closer to zero.  

- ROUNDUP: Rounds the number up in the direction away from zero.  

- SERIESSUM: Use radical expansion to approximate various functions.  

- SIGN: Determines the sign of a number.  

- SIN: Returns the sine of a given angle.  

- SINH: Returns the hyperbolic sine of a number.  

- SQRT: Returns the square root of a positive number.  

- SQRTPI: Returns the square root of (number * pi).  
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- SUM: The SUM function adds values. You can add individual values.  

- TAN: Returns the tangent value of a given angle.  

- TANH: Returns the hyperbolic tangent value.  

- TRUNC: Discards the decimal places in a number and converts it to an integer.

❷ Statistical functions

- AVERAGE: Returns the average of the arguments (operational average).  

- COUNT: Counts the number of numbers in a list of variables that contain numbers.  

- MAX: Returns the largest value in a set of values.  

- MEDIAN: Returns the median value of a given set of numbers.  

- MIN: Returns the smallest number in a set of values.  

- STDEV: Finds the standard deviation of a sample population.  

- VAR: Estimates the variance of a sample.

❸ Logical functions

- �AND: Uses the AND function, one of the logical functions, to check that all conditions in the test are TRUE. 

- FALSE: Returns the logical value FALSE.  

- IF: A function that allows you to logically compare a specific value to an expected value.  

- NOT: Returns TRUE to FALSE and vice versa.  

- OR: Returns TRUE if any of the arguments are TRUE.  

- TRUE: Returns the logical value TRUE. 
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4-4 Others

4-4-1 S/W Update

❶ Run the View.msi fi le you were provided.

❷ Follow the same steps as the installation.

❸  RRun the program to check the version. If you install a higher version, the higher version will be installed 

automatically without uninstalling the program.

4-4-2 Upgrading features

❶ Place the fi le (Function.fg) provided by the manufacturer in the root of the USB.

❷ Insert the USB into your PC.

❸ Go to Home > Settings & Help > About > Press the [About] button.

❹ Press the [Upgrade] button next to the serial number, as shown in the screen below.

❺ When the upgrade is complete, re-run the program.

4-4-3 SW Mode

❶ Normal: Allows you to use all features of the device without restrictions.

❷ Security & GLP Mode

- If you need to secure your device, change to Security GLP mode.

-  Inherits the account information and permissions of the device. You must sign in with the device's 

account information, and the same permissions will be used to restrict functionality.

- To change permissions, change them on the device.

- View permissions list

· Change Parameters: Permission to change setting values in Options

· Change Calibration Curve: permission to enter the user's absorbance in the standard curve

· Load Parameters: Permission to load parameters

· Save Parameters: Permission to save parameters

· Load Data Files: Permission to load data fi les

· Save Data Files: Permission to save data fi les

Ch.4
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